How can remote sensing contribute to producing spatial and temporal statistics
- Combating Climate Change -

Yoshifumi YASUOKA
Director, Center for Environmental Remote Sensing
Chiba University

Launch of GOSAT ("IBUKI")
on January 23, 2009

Topics

1. Understanding of our world
2. Remote sensing of our world
3. Towards sustainable world
**What is Remote Sensing?**

Remote Sensing Image  
Remote Sensor  

A tool to observe earth surface conditions from space

---

**Remote Sensing**

is a measurement tool to

to characterize land, ocean and atmosphere conditions

without directly contacting the objects.

- It utilizes electromagnetic waves as a medium
  throughout optical to microwave range.

- It usually utilizes so-called remote sensors
  on board satellite, aircraft, ship or UAV.
Spectral Signature

* All matter reflects, absorbs, transmits and emits electromagnetic radiation in a unique way with respect to wavelength.

Spectral data observed at Khon Kaen in 1987

Inundated paddy

Cassava

Lake

Spectrometer:
Abe2703MM 17 channels (400nm-1100nm)
Spectral measurement
(Khon Kaen, 1990/2/18)
Worldview-3 images over Fukushima Nuclear Power plant (31cm resolution)

Global/Continental Scale

Regional/Local scale

NOAA/AVHRR

Reflectance of Concrete, Soil, Dry leaf, Green leaf and Granite (岩盤)
Spectral data
Land and ocean surface condition over Japan

Sea surface temp. (from AVHRR)  2001 Monthly Vegetation index (from AVHRR)

Remote sensing in different wavelength range

Visible  thermal IR  microwave
What is remote sensing?

Remote sensing is a part of earth observation

Earth observation is a part of understanding our world

Understanding of our world is a part of improving our world

Improving our world is a part of realizing sustainable world

Policy

Increase of CO2 concentration observed at Mauna Loa

Keeling Curve
(Mauna Loa Observatory)
Comparison of monthly average XCO2 (CO2 column density) over US and Australia

(TANSO-FTS SWIR Level 2 (Ver.02,**)

GOSAT; Greenhouse gases Observing Satellite

USA
Australia

Launch of GOSAT ("IBUKI") on January 23, 2009
Comparison of monthly average XCO2 (CO2 column density) over US and Australia

(TANSO-FTS SWIR Level 2 (Ver.02.**))

GOSAT; Greenhouse gases Observing Satellite

USA
Australia

Integration of different science and technologies

How to integrate?

@ Climate change is an urgent threat to us.
Mitigation tools for global warming

@ Electric car (EC) & Fuel cell vehicle (FCV)
@ Solar power generation system & Wind power generation system
@ etc.

Topics

1. Understanding of our world
2. Remote sensing of our world
3. Towards sustainable world
Topics

1. Understanding of our world
   
   Three cycles in sustainability research
   @ Man and environment interaction cycle
   @ Causality cycle (DPSIR cycle)
   @ Action cycle

2. Remote sensing of our world

3. Towards sustainable world
   SATREPS, Future Earth and SDGs

![Diagram showing the understanding of our world cycle]

Human

Energy

Resources

Impact to Nature

Negative Impact: Global Warming

Feedback

If this cycle works well we may say it is sustainable!
Remarks

1. Boundary condition
   Spatial boundary: region, country, ..., globe
   Temporal boundary: 1yr, 10yrs, ..., 100yrs

2. Human dimension
   Current generation vs next generation
   Developed country vs developing country
   Country A vs Country B
Topics

1. Understanding of our world

   Three cycles in sustainability research
   @ Man and environment interaction cycle
   @ Causality cycle (DPSIR cycle)
   @ Action cycle

2. Remote sensing of our world

3. Towards sustainable world

   SATREPS, Future Earth and SDGs
From data, information, intelligence to strategy and policy

Statistical thinking plays vital role.

Observation, Survey → Modeling → Simulation → Taking measures & Optimization → Control Management

Data → Information → Intelligence → Strategy → Policy

Effect

Observation and evaluation of effect of policy is important.
Backcasting from policy to up-stream is also very important.

Observation and mitigation measures are independent so far.
From data, information, intelligence to strategy and policy
Global scale observation assessment is not easy.

Observation, Survey → Modeling → Simulation → Taking measures & Optimization
Control → Management → Policy → Effect

Knowledge → Inference

Observation and assessment of effect of policy is important.

Topics

1. Understanding of our world
2. Remote sensing of our world
3. Towards sustainable world
Towards Sustainable World

- How was in the past?
- How is it at present?
- How will it be in the future?
- How can we improve our world?

Observation → Model prediction → Countermeasures

Remote Sensing

Parameter distribution

Our contribution

Time Series NDVI Pattern from 1984-2004
(August 1 to August 10)

Sensor was changed to AVHRR3 after 2001

IIS/UT
Plant Phenology in NDVI Change

- **DOY Spring** = Max \{ DOY \_t – DOY \_t-1 \}
- **DOY Summer** = Max \{ DOY \_t \}
- **DOY Autumn** = Min \{ DOY \_t – DOY \_t-1 \}
- **DOY Active** = DOY \_autumn – DOY \_spring

Leaf development is getting earlier for some biome types

Mixed and Broad Leaf Forest

Mixed forest: 12 days, Deciduous broad leaf forest: 14 days in 21 years

Dr. Ooyoshi, IIS/UT
Distribution of DOY in Leaf Development

DOY for Leaf Development

Dr. K Ohyoshi

Precipitable Water

AVHRR PW: Precipitable Water estimated from NOAA/AVHRR

2001/6/4 2001/10/6

Dr. Akatsuka, IIS/UT
Trend of Precipitable Water (October)

- Wakkanai: $y = 0.42x + 7.48$
- Sapporo: $y = 0.58x + 8.85$
- Akita: $y = 0.44x + 10.57$
- Sendai: $y = 0.60x + 12.06$
- Wajima: $y = 0.34x + 10.45$
- Tateno: $y = 0.42x + 16.66$
- Yonago: $y = 0.52x + 10.92$
- Shionomisaki: $y = 0.32x + 13.87$
- Hukuoka: $y = 0.32x + 14.61$
- Kagoshima: $y = 0.70x + 13.78$
- Urako: $y = 0.33x + 12.42$

Decrease of Arctic sea ice extent (1978-now)

- Advance Microwave Scanning Radiometer (AMSR)
### Forest fire monitoring

<table>
<thead>
<tr>
<th>Year</th>
<th>January</th>
<th>February</th>
<th>March</th>
<th>April</th>
<th>May</th>
<th>June</th>
<th>Total</th>
</tr>
</thead>
<tbody>
<tr>
<td>1984</td>
<td>0</td>
<td>0</td>
<td>0</td>
<td>0</td>
<td>0</td>
<td>0</td>
<td>0</td>
</tr>
<tr>
<td>1985</td>
<td>0</td>
<td>0</td>
<td>0</td>
<td>0</td>
<td>0</td>
<td>0</td>
<td>0</td>
</tr>
<tr>
<td>1986</td>
<td>0</td>
<td>0</td>
<td>0</td>
<td>0</td>
<td>0</td>
<td>0</td>
<td>0</td>
</tr>
<tr>
<td>1987</td>
<td>0</td>
<td>0</td>
<td>0</td>
<td>0</td>
<td>0</td>
<td>0</td>
<td>0</td>
</tr>
<tr>
<td>1988</td>
<td>0</td>
<td>0</td>
<td>0</td>
<td>0</td>
<td>0</td>
<td>0</td>
<td>0</td>
</tr>
<tr>
<td>1989</td>
<td>0</td>
<td>0</td>
<td>0</td>
<td>0</td>
<td>0</td>
<td>0</td>
<td>0</td>
</tr>
<tr>
<td>1990</td>
<td>0</td>
<td>0</td>
<td>0</td>
<td>0</td>
<td>0</td>
<td>0</td>
<td>0</td>
</tr>
<tr>
<td>1991</td>
<td>0</td>
<td>0</td>
<td>0</td>
<td>0</td>
<td>0</td>
<td>0</td>
<td>0</td>
</tr>
<tr>
<td>1992</td>
<td>0</td>
<td>0</td>
<td>0</td>
<td>0</td>
<td>0</td>
<td>0</td>
<td>0</td>
</tr>
<tr>
<td>1993</td>
<td>0</td>
<td>0</td>
<td>0</td>
<td>0</td>
<td>0</td>
<td>0</td>
<td>0</td>
</tr>
<tr>
<td>1994</td>
<td>0</td>
<td>0</td>
<td>0</td>
<td>0</td>
<td>0</td>
<td>0</td>
<td>0</td>
</tr>
<tr>
<td>1995</td>
<td>0</td>
<td>0</td>
<td>0</td>
<td>0</td>
<td>0</td>
<td>0</td>
<td>0</td>
</tr>
<tr>
<td>1996</td>
<td>0</td>
<td>0</td>
<td>0</td>
<td>0</td>
<td>0</td>
<td>0</td>
<td>0</td>
</tr>
<tr>
<td>1997</td>
<td>0</td>
<td>0</td>
<td>0</td>
<td>0</td>
<td>0</td>
<td>0</td>
<td>0</td>
</tr>
<tr>
<td>1998</td>
<td>0</td>
<td>0</td>
<td>0</td>
<td>0</td>
<td>0</td>
<td>0</td>
<td>0</td>
</tr>
<tr>
<td>1999</td>
<td>0</td>
<td>0</td>
<td>0</td>
<td>0</td>
<td>0</td>
<td>0</td>
<td>0</td>
</tr>
<tr>
<td>2000</td>
<td>0</td>
<td>0</td>
<td>0</td>
<td>0</td>
<td>0</td>
<td>0</td>
<td>0</td>
</tr>
<tr>
<td>2001</td>
<td>0</td>
<td>0</td>
<td>0</td>
<td>0</td>
<td>0</td>
<td>0</td>
<td>0</td>
</tr>
</tbody>
</table>

**Note:** The data represents burned and unburned areas.

---

**DISASTERS**

Dr. J. Kucera, IIS/UT
Percentage (fraction) of paddy field in one square kilometer

Dr. W. Takeuchi, IIS/UT

Comparison of monthly average XCO2 (CO2 column density) over US and Australia

(TANSO-FTS SWIR Level 2 (Ver.02.**))
Seasonal Variation of CO₂ Distribution
Observed by GOSAT (Ibuki)
2.5° mesh average map of CO₂ column (Ver.02.00)

DR. YOKOTA, NIES

Seasonal Variation of CH₄ Distribution
Observed by GOSAT (Ibuki)
2.5° mesh average map of CH₄ column (Ver.02.00)
Satellite observation of forest cover

Vegetation Index; summer

June - July

Satellite observation of forest cover

Vegetation Index; winter

Toward Sustainable World

How was in the past?

How is it at present?

How will it be in the future?

How can we improve our world?

Observation

Model prediction

Countermeasures

Remote Sensing

Parameter distribution

Our contribution

How will it be in the future?

@ Remote sensing can not project the future.

@ We need model simulation to project the future.

@ Remote sensing may be used to estimate model parameters by assimilating it with models.
Climate Projection (NIES-CCSR-FRCGC model)

Trend in Number of Hot Days in Japan

Temperature over 30°C in 100km×100km grid

NIES-CCRS/UT-FRSGC K-1, A1B (After CCSR/UT)
Need to observe, elucidate, model, predict, assess and manage processes, and to reduce negative impact.

Toward Sustainable Society

Human

Energy

Resources

Impact to Nature

Atmosphere

Water

Land

Ecosystem

Human Activities

Produce

Utilize

Abandon

Change Land Cover

Impact to Human

Negative Impact: Global Warming

Feedback

Human Activities

CO2 emission

deforestation

High CO2

we may say it is sustainable!
Topics

1. What’s going on in the world?
2. Remote sensing of our world
3. Towards sustainable society
   SATREPS, Future Earth and SDGs

Collaboration between S&T and Society

@ “SATREPS” by JST and JICA (2008)
   --- International (bi-lateral) collaborative research program to
      solve social problems in counter country

@ “Future Earth” by ICSU and Vermont Forum (2012)
   --- Integration of WCRP, IGBP, IHDP and DIVERSTAS to
      solve the wicked problems

@ SDGs by UN (2015)
   --- 17 goals and 169 targets to transform our world with concept of
      “no one left behind”
SATREPS

Science and Technology Research Partnership for Sustainable Development

Japan Science and Technology Agency (JST)

&

Japan International Cooperation Agency (JICA)

SATREPS Projects

In total (since 2008) : 115 projects with 46 countries

As of March, 2017
Program Description

(1) Research fields
- Environment
- Energy
- Bio Resource Utilization
- Disaster Prevention and Mitigation
- Infectious Disease Control

(2) Research period: 3-5 years

(3) Research budget: 1M USD/Project/year

SATREPS
Science and Technology Research Partnership for Sustainable Development

Science and Technology x International Cooperation (Bi-lateral collaboration)

Global Issues x Local Needs (Social Implementation)

Japan’s Capability x Counter Country’ Capability
Stakeholder’s involvement in SATREPS Project

1. Joint Coordination Committee (JCC) is organized in each project to promote research and to watch the progress.

2. Stakeholders in the counter country are involved in the JCC to co-design the project from the beginning.

3. In particular, policy makers are involved in the JCC to realize social implementation of the research results.
New Project between Indonesia and Japan from 2017

Development and Implementation of New Damage Assessment Process in Agricultural Insurance as Adaptation to Climate Change for Food Security

Principal Investigators
Japan side;
Prof. Chiharu HONGO
Center for Environmental Remote Sensing, Chiba University

Indonesian side;
Prof. Baba Barus
Bogor Agricultural University

Seeds research (in Indonesia)

Practical application of satellite data to Agricultural Insurance (2013-2016)

Yield estimation on individual field (Bali)
Decrease in yield of 2014 against average yield of last 10 years (west Java)

Yield estimation on area (Japan)

Copyright © C. HONGO Ph. D 2016 All rights reserved.
United Nations (UN) adopted the 17 SDGs of the 2030 Agenda for sustainable development in September 2015, and it entered into force in January 2016.

The Sustainable Development Goals (SDGs)

A. 17 SDGs and 169 targets

B. All UN countries including developing and developed countries

C. Indicators and monitoring framework in each country

D. Monitoring by UN

E. In Japan, Prime Minister’s Office leadership in promoting SDGs

ST&I may play a vital role in promoting SDGs.
Future Earth Program
by
ICSU, UNESCO, Belmont Forum,
NSF, JST, etc.

UNESCO & ICSU Budapest declaration

“Science for Society and Science in Society”
is added besides
Science for Knowledge,
Science for Peace and
Science for Development
as a new theme (1999)

Still we have many unsolved problems although many scientific papers have been published, and many new knowledges have been developed.

What is missing, and what should be added?
What is Future Earth?

- Is a **global platform** for international research collaboration on global environmental change and sustainable development
- Provides integrated research on major **global change challenges and transformations to sustainability**
- Strengthens partnerships between researchers, funders and users of research through **co-design/co-production** of research
- Is **solutions-oriented**, aiming to generate knowledge that contributed to new more sustainable ways of doing things

Trans-disciplinary Approach

**Principal idea is to link S&T with society.**

- **MONO**
- **MULTI**
- **INTER** (within & beyond fields of science)
- **TRANS**

*Bunders et al, 2009*
Common aspects among SATREPS, Future Earth and SDGs

@ Addressing global sustainability

@ Solution oriented approach

@ Social implementation

@ Stakeholders involvement

@ SATREPS and FE; in Academia

SDGs; not limited to Academia
Global and Local Aspect in SATREPS

Solution Based

Global

Local

Analysis Based

Extension of SATREPS Local Knowledge to Global

How to extend local knowledge in each SATREPS project to other areas, and to global scale?

@ To identify customized knowledge and commonized knowledge
@ To extend commonized knowledge
@ To integrate customized knowledge
Customization of Country Level Criteria in SDGs

Customization  Commonized aspect
Solution Based

Local  Global

Analyzing Based

Customization and Commonization in SATREPS and SDGs

Customization  Commonized aspect
Solution Based

Local  Global

Customized Research  Commonization
Customization and Commonization in SATREPS and SDGs

Pathways from Remote Sensing toward Sustainable World

SATREPS, Future Earth and SDGs are all international programs addressing global sustainability.
Conclusions

Combating climate change

# needs to cover from urban scale (local/regional) to global --- spatial dimension

# needs to cover from short-term to long-term --- temporal dimension

# needs to cover a variety of variables --- variable dimensions

# needs to integrate monitoring, modeling and assessment with management

Remote Sensing can contribute a lot!